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Introduction
Welcome to the Wavetronix SmartSensorTM HD user guide.

Figure 1. SmartSensor HD

This guide will cover selecting a mounting location for, installing, and 
configuring a SmartSensor HD. To find the instructions for specific 
tasks, see the table of contents. If your questions aren’t answered in this 
guide, visit www.wavetronix.com/support for access to supplemental 
materials, like technical documents and troubleshooting information.

What you’ll need
The sensor package includes the following:

˿˿ A SmartSensor HD
˿˿ A mounting backplate
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˿˿ A SmartSensor HD quick start guide

The following aren’t automatically included but are necessary for 
installation:

˿˿ Sensor mount
˿˿ SmartSensor 8-conductor cable

To support the sensor installation, you may need to order devices for 
power conversion, surge protection and communication, including 
some or all of the following:

˿˿ Contact closure device (Click 100, 104, 110, or 112/114)
˿˿ Click 200 surge protector
˿˿ Click 201/202 AC to DC converter
˿˿ Click 210 circuit breaker
˿˿ Click 230 AC surge protector
˿˿ Click 301 serial to Ethernet converter

For convenience, you can get these devices preassembled and prewired 
in pole-mount boxes and cabinet backplates, available from Wavetronix.

Service information
Don’t try to service or repair this unit; none of its components or 
parts are serviceable in the field. Attempting to open this unit, unless 
expressly directed by Wavetronix, will void the customer warranty, as 
will any visible damage to exterior seal labels. Wavetronix is not liable 
for any bodily harm or damage caused if unqualified persons attempt to 
service or open the back cover of this unit. Refer all service questions to 
Wavetronix or an authorized distributor.

Important note
Failure to follow the installation guidelines laid out in this guide could 
result in decreased performance. If you believe it is necessary to deviate 
from these guidelines, contact a Wavetronix application engineer or 
technical support for assistance and recommendations.
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1
 Choosing a Mounting 

Location

 Mounting location, height and offset
 Choosing where to mount

Figure 2.  The HD’s radar footprint

 ˿ For best performance, make sure the lanes being detected are all 
parallel to each other; avoid  on- and off -ramps/turn lanes that angle 
away from the road.
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 ˿ Make sure all monitored lanes are within  6 to 250 ft . (1.8 to 76.2 m) 
of the sensor. Up to  22 lanes can be detected.

 ˿ If you’re putting a sensor on a road with stoplights or stop signs, 
position the sensor toward middle of the block, to reduce the likeli-
hood of having stopped vehicles in the HD radar footprint.

Figure 3.  Midblock installation

 ˿ Keep  cable lengths in mind when you pick  mounting locations; 
when you use the Wavetronix cable, cables can be as long as 600 ft . 
(182.9 m) if you’re using 24 VDC and  RS-485 communications; for 
longer connections, consider alternate wired and  wireless options.

 ˿ Consider timing: aft er a vehicle passes in front of the sensor, there’s 
a slight delay before the data for that vehicle is sent from the sensor. 
In a time-sensitive application, like supplying a variable message 
sign with per vehicle warning messages, make sure the sensor is far 
enough upstream from the sign that the system has time to collect 
the data, process it, and send it to the sign by the time the vehicles 
reach the problem area.

˿ See if you can take advantage of any existing infrastructure in the 
area. Th e sensor can be mounted on existing poles (with the excep-
tion of wooden poles and trees), as long as they fall within the 
acceptable off set range. You may also be able to tap into existing 
cabinets, power sources, and communication networks. All of these 
options could save you time and money. 

For more information.
See the HD support 

section of the 
Wavetronix website 
to learn more about 

cable lengths.
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Choosing a mounting height and offset
Mounting guidelines in feet

Offset Height (acceptable range)
6* 12 (9–19)
7* 12 (9–19)
8* 12 (9–20)
9 12 (9–21)

10 12 (9–22)
11 12 (9–23)
12 13 (10–24)
13 13 (11–25)
14 14 (11–28)
15 15 (12–26)
16 15 (12–27)
17 16 (13–28)
18 17 (14–29)
19 17 (14–30)
20 18 (15–30)
21 19 (15–31)
22 20 (16–31)
23 22 (16–32)
24 24 (16–33)
25 26 (17–33)
26 26 (17–34)
27 27 (18–35)
28 27 (18–35)
29 27 (18–36)
30 29 (19–37)
31 29 (19–37)
32 29 (19–38)
33 30 (19–39)
34 30 (19–39)
35 30 (20–40)
36 30 (20–41)
37 31 (20–41)
38 31 (21–42)
39 33 (21–43)
40 33 (22–43)
41 34 (22–44)
42 34 (22–44)
43 35 (22–45)
44 35 (23–46)
45 36 (23–46)
46 36 (23–47)
47 36 (24–48)
48 38 (24–48)
49 38 (24–49)

50–230 39 (25– <offset)

Note. Mounting height 
is measured from the 
road’s height, not the 
bottom of the pole. If 
installing a new pole, 
remember that part 
of the pole will likely 
be below ground.

Definition. Offset is 
the distance between 
the pole the sensor 
is mounted on and 
the edge of the first 
lane to be detected.

R
ec

om
m

en
de

d

*reduction 
in number of 

reported speeds



12  •  SmartSensor HD User Guide

Mounting guidelines in meters

Offset Height (acceptable range)
2.0* 3.5 (2.5–5.5)
2.5* 3.5 (2.5–5.5)
3.0 3.5 (2.5–5.5)
3.5 3.5 (3.0–6.0)
4.0 4.0 (3.0–7.0)
4.5 4.5 (3.5–7.5)
5.0 4.5 (3.5–8.0)
5.5 5.0 (4.0–9.0)
6.0 5.5 (4.5–9.0)
6.5 6.0 (4.5–9.5)
7.0 6.5 (5.0–10.0)
7.5 8.0 (5.0–10.0)
8.0 8.0 (5.0–10.5)
8.5 8.0 (5.5–10.5)
9.0 8.5 (5.5–11.0)
9.5 8.5 (5.5–11.5)

10.0 9.0 (6.0–12.0)
10.5 9.0 (6.0–12.0)
11.0 9.0 (6.0–12.5)
11.5 9.5 (6.5–13.0)
12.0 10.0 (6.5–13.0)
12.5 10.5 (6.5–13.5)
13.0 10.5 (7.0–13.5)
13.5 11.0 (7.0–14.0)
14.0 11.0 (7.0–14.0)
14.5 11.5 (7.5–14.5)
15.0 11.5 (7.5–15.0)

15.5–70 12.0 (7.5– <offset)

Additional information
˿˿ If the roadway is frequently used by tall vehicles, consider choosing a 

higher mounting height to help avoid occlusion.
˿˿ Don’t use an offset of less than 6 ft. (1.8 m). Also, the sensor can be 

up to 230 ft. (70.1 m) from the road, but don’t go out that far if you 
can avoid it; it could lead to decreased accuracy. 

˿˿ For best results, choose the mounting height in the Height column 
in the table. If you can’t, just keep it somewhere in the acceptable 
range.

Note. Some countries, 
such as the UK, have 

their own variant 
of these mounting 

guidelines due to 
differences in road 
layouts and traffic 

profiles. Please 
consult with your 
local Wavetronix 
office to ensure 

you are installing 
to the correct local 

guidelines.

*reduction 
in number of 

reported speeds
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Warning. Choosing 
a mounting height 
outside that range 

could negatively affect 
sensor accuracy.
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 Occlusion and  multipathing
Th ese are two problems you might face while using a radar detector.

Figure 4. Occlusion

Occlusion occurs when one object blocks another object from the sen-
sor’s view, as shown above. Th is can happen with

 ˿ Tall vehicles like  semi trucks
 ˿ Signs
 ˿ Barriers and  sounding walls
 ˿ Trees and more

Normal
detection

Signal that doesn’t 
return to sensor is 

scattered

Signal bouncing off 
wall causes false 

detection 

Figure 5. Left: direct path return; right: multipath return

Multipathing occurs when a large fl at surface near the sensor interferes 
with detection. A radar signal can bounce around several times between 
the surface and the vehicles before returning to the sensor. Th is can 
make the sensor detect a vehicle where there is none.



14  •  SmartSensor HD User Guide

This can happen with
˿˿ Buildings
˿˿ Signs
˿˿ Guard rails
˿˿ Sounding walls and more

Fixing occlusion problems
˿˿ Move the sensor higher on the pole (keeping it within the recom-

mendations in the mounting guidelines table).
˿˿ Move the sensor to another spot on the freeway if possible, away 

from obstructions.
˿˿ If there’s a very large barrier in the median, you could do the following:

̀̀ Use one sensor on either side of the road, pointing in (be sure to 
give the two sensors a 70-ft./21.3-m lateral offset and put them on 
different RF channels).

̀̀ Put two sensors on the same pole in the middle of the median, 
both pointing out (put them on different RF channels), but this 
would mean they are next to the barrier in the median and that 
could cause multipath problems.

Fixing multipath problems
˿˿ Move the sensor if possible; make sure it is separated from overhead 

signs, overpasses, tunnels, parallel walls, etc. A 30-ft. (9.1-m) lat-
eral separation would be ideal, but even just a few feet can make a 
difference.

˿˿ Adjust the sensor’s sensitivity thresholds in SmartSensor Manager 
HD, as covered in chapter 8.

Note. A good rule of 
thumb is that 50% of a 
vehicle must be visible 

above any barrier in 
order to be detected.
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2
Installing the 

SmartSensor HD

Attaching the mount to the pole

Figure 6. Attaching the mount

1	 Insert the mounting straps through the slots on the mount.
2	 Position the mount on the pole at the height you chose from the 

mounting table in the previous chapter.
3	 Point the head of the mount toward the middle of the lanes you want 

to detect.
4	 Tighten the straps.

Note. Be sure to 
keep the straps 
adjustable, because 
once you’ve used the 
alignment tool in the 
software, you may 
need to fine-tune the 
sensor’s positioning.
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 Attaching the sensor to the  mount

Figure 7. Attaching the sensor

1 Align the bolts on the sensor’s backplate with the holes in the mount.
2 Make sure the large 10-pin connector at the bottom of the unit is 

pointing towards the ground.
3 Push the bolts through the mount holes.
4 Place the lock washers on the bolts, thread on the nuts and tighten.

 Aligning the sensor to the roadway

Figure 8. Up-and-down positioning

1 Tilt the sensor down so the front is aimed at the center of the detec-
tion area.
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Figure 9. Rotating the sensor on a  hill: incorrect (left) and correct (right)

2 If the sensor is installed on a road with an uphill/downhill grade, 
rotate the sensor so that the bottom edge matches the grade of the 
road (this will require the purchase of a rotating sensor backplate). 

Figure 10. Side-to-side positioning

3 Adjust the side-to-side angle so it’s perpendicular to the fl ow of traffi  c.

 Applying  silicon dielectric  compound

Figure 11. Applying the compound
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1	 Tear the tab off the tube of silicon dielectric compound that came 
with the sensor.

2	 Squeeze about half of the compound on the connector at the base of 
the sensor.

Connecting the cable

Figure 12. Cable run through pole (left) and through conduit (right)

1	 Insert the cable connector into the sensor connector. Be aware that it 
is a keyed connector.

2	 Twist the cable connector clockwise until you hear it click into place.
3	 Run the cable through the pole. Leave a small amount of slack at the 

top; this reduces strain, allows you to create a drip loop as shown 
above, and gives you something to work with should you someday 
need to move the sensor to a different spot on the pole.

4	 If there’s excess cable, don’t cut it, as you may need it at a later time; 
leave it in the pole.

Note. The HD sensor 
uses an 8-conductor 

cable that can 
be ordered from 

Wavetronix. It’s also 
possible to order a 
retrofit HD with a 
legacy connector; 

this would use the 
older 9-conductor 

SmartSensor cable.

Note. When you run 
the cable through the 

pole, don’t drill through 
the sensor mount, as 

the sensor and sensor 
mount may need to be 
adjusted in the future.
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3
Installing Power, Surge 

Protection and Communications

How you install power, surge protection and communication modules 
varies based on what enclosures you’re using and where they’re located.

Installations with a pole-mount box only
As shown below, this is an installation where the sensor cable runs down 
the pole to the pole-mount box and to nowhere else. Power comes from 
solar, a battery, or a power line that runs straight to the pole; communi-
cations are wireless or use a comms line that runs straight to the pole.

Figure 13. Installation with pole-mount box and no cabinet

Warning. We strongly 
recommend you follow 
the guidelines in this 
chapter, especially as 
they relate to surge 
protection. Failure to 
properly protect your 
sensors from surges 
will void the sensor 
warranty. If you need 
more information, 
contact support@
wavetronix.com.
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Setting up the pole-mount box
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Figure 14. Standard Preassembled Cabinet (pole-mount box)

Figure 15. Attaching the pole-mount box

1	 Find the mounting brackets that were included in the package and 
attach them to the back of the Standard Preassembled Cabinet.

2	 Use Band-It or a similar clamping system to attach the Standard Pre-
assembled Cabinet to the pole.

Note. This section 
assumes you are 

using the Standard 
Preassembled Cabinet 

from Wavetronix. If 
you bought individual 

Click modules instead, 
see Click 100–400 

Series User Guide and 
support document  

295, How to Assemble 
the Power Plant. If 
you are not using 

Wavetronix devices, 
contact your dealer or 

visit the knowledge 
base at www.

wavetronix.com.
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Figure 16. Connecting power cable to terminal blocks

3	 Insert the power cable through the leftmost cable grip on the bottom 
of the box. Twist the cable grip to tighten.

4	 Insert the black conductor into the round hole on the plug portion 
of the L terminal block. Insert a small screwdriver into the square 
hole above it, and rock upwards to secure the conductor in place.

5	 Repeat step 4 with the white conductor in the N terminal block, and 
the green conductor in the G terminal block, as shown above.
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Figure 17. Connecting sensor cable to terminal blocks

6	 Insert the sensor cable (the pigtail cable coming from the sensor)
into the middle grip on the bottom of the box. Twist the cable grip to 
tighten.

7	 Follow the instructions in step 4 to land each conductor into the 
correct terminal block. The blocks are color-coded for your conve-
nience: land the red conductor into the block with the red label, and 
so on.
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Figure 18. Connecting earth ground

8	 Connect the grounding lug to earth ground.

More information about this setup
This cabinet is designed to be mounted on a pole and to provide every-
thing your sensor needs:

˿˿ The Click power plant, consisting of a circuit breaker, AC surge pro-
tector, and AC to DC converter.

˿˿ The Click 200, which is a lightning surge protector. This device is 
where the sensor cable is landed (via the terminal blocks). It protects 
the rest of the pole-mount box from surges coming from the sensor 
cable. It’s also where you can plug in to communicate with and con-
figure the sensor.

There are no communication options besides the RS-232 and RS-485 on 
the Click 200. An additional communication device can be easily added 
to communicate with the installation remotely.

Warning. For installs 
with only the pole-
mount box (no traffic 
cabinet), you need 
the single Click 200 
in the Standard 
Preassembled Cabinet. 
Failure to use a Click 
200 could void the 
sensor warranty. 
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Installations with a pole-mount 
box and traffic cabinet
As shown below, this is an installation where the sensor cable runs down 
the pole to the pole-mount box, then down to ground level, where it 
runs underground to a traffic cabinet. Power and communication mod-
ules are located in the cabinet, and power is sent to the sensor via the 
sensor cable.

Figure 19. Installation with pole-mount box and traffic cabinet

Setting up the pole-mount box

Lightning
Surge

Protection

Wavetronix

Pr
ot

ec
te

d
Pr

ot
ec

te
d

Click!
200

RS
-4

85
RS

-2
32

 D
CE

To Sm
artSensor

GNDGNDRDTDCTSRTSGND485+485-GND-DC+DC

To Tra�
c Cabinet

GNDGNDRDTDCTSRTSGND485+485-GND-DC+DC

Figure 20. Surge Preassembled Cabinet (pole-mount box)

Note. This section 
assumes you are 

using the Standard 
Preassembled Cabinet 

from Wavetronix. If 
you bought individual 

Click modules instead, 
see Click 100–400 

Series User Guide and 
support document  

295, How to Assemble 
the Power Plant. If 
you are not using 

Wavetronix devices, 
contact your dealer or 

visit the knowledge 
base at www.

wavetronix.com.



Chapter 3:  Installing Power, Surge Protection and Communications  •  25

Figure 21. Attaching the pole-mount box

1	 Find the mounting brackets that were included in the package and 
attach them to the back of the Surge Preassembled Cabinet.

2	 Use Band-It or a similar clamping system to attach the Surge Preas-
sembled Cabinet to the pole.
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Figure 22. Connecting sensor cable to terminal blocks

3	 Insert the sensor cable (the pigtail cable coming from the sensor) 
through the rightmost cable grip on the bottom of the box. Twist the 
cable grip to tighten.

4	 Start connecting conductors to the terminal blocks marked “To Smart-
Sensor”: insert the red conductor into the round hole on the plug 
portion of the +DC terminal block. Insert a small screwdriver into the 
square hole above it, and rock upwards to secure the conductor in place.

5	 Repeat step 4 to land each conductor into the correct terminal block. 
The blocks are color-coded for your convenience: land the black 
conductor into the block with the black label, and so on.
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Figure 23. Connecting homerun cable to terminal blocks

6	 Insert one end of the homerun sensor cable (the cable that runs to 
the traffic cabinet) into the leftmost grip on the bottom of the box. 
Twist the cable grip to tighten.

7	 Follow the instructions in steps 4 and 5 to land each conductor into 
the correct spots in the set of terminal blocks marked “To Traffic 
Cabinet,” remembering to follow the color-coded labels.
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Figure 24. Connecting earth ground

8	 Connect the grounding lug to earth ground.
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Setting up the traffic cabinet
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Figure 25. Standard Preassembled Backplate (for traffic cabinet)
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Figure 26. Mounting the backplate in the cabinet

1	 If you haven’t already, run the homerun cable back to the traffic 
cabinet.

2	 Use the included screws to mount the Standard Preassembled Back-
plate in the traffic cabinet.

Note. This section 
assumes you are 
using the Standard 
Preassembled 
Backplate from 
Wavetronix; if you 
bought individual 
Click modules instead, 
see Click 100–400 
Series User Guide and 
support document 
295, How to Assemble 
the Power Plant.
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Figure 27. Connecting power cable to terminal blocks

3	 Start by connecting the power cable. This backplate is shipped from 
Wavetronix with the conductors in the cable already terminated in a 
terminal block plug. Insert this plug into the power terminal blocks. 

4	 If for some reason the conductors aren’t terminated into the termi-
nal block plug, terminate them by inserting each conductor into the 
corresponding round hole on the plug (match each conductor to the 
label of the same color on the plug). Insert a small screwdriver into 
the square hole above it, and rock upwards to secure the conductor 
in place. Repeat with each conductor.
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Figure 28. Connecting sensor cable to terminal blocks

5	 Now wire the sensor cable (the homerun cable coming from the 
pole-mount box): follow the instructions in step 4 to land each con-
ductor into the correct terminal block. The blocks are color-coded 
for your convenience: land the red conductor into the block with the 
red label, and so on.

6	 Make sure the backplate is connected to earth ground.

More information about this setup
Following this section provides everything your sensor needs:

˿˿ The Click power plant, consisting of a circuit breaker, AC surge pro-
tector, and AC to DC converter, located in the traffic cabinet.

˿˿ Two Click 200 modules, which are lightning surge protectors, one at 
either end of the underground cable run. This protects all the equip-
ment, especially the sensor, from power surges on the cable, such as 
those caused when lightning hits the ground near where it’s buried, 
which makes these very important! It’s also where you can plug in to 
communicate with and configure the sensor.

There are no communication options in this setup besides the RS-232 
and RS-485 on the Click 200. An additional communication device can 
be easily added to communicate with the installation remotely.

Note. All electronic 
components should 
be grounded.

Warning. Using two 
Click 200s is standard 
Wavetronix procedure 
for underground 
cable runs. Failure 
to follow these 
guidelines will void 
the sensor warranty. 
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4
Installing and Running 

SmartSensor Manager HD

Download and installation
SmartSensor Manager HD (SSMHD) is software that lets you configure 
and interact with the HD sensor. It can only be installed on a PC.

Downloading SSMHD

Figure 29. Finding the SSMHD download on the Wavetronix website

1	 In a browser, navigate to www.wavetronix.com/en/support.
2	 From the Start by drop-down menu, select SmartSensor HD.
3	 The HD page will appear. Under the Software section, click Smart-

Sensor Manager HD vX.X.X Setup. If you are prompted, click the 
Download button.
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Installing SSMHD

Figure 30. SSMHD install wizard

1	 Double-click on the setup file.
2	 Follow the instructions on your screen to choose where to install, 

and then to choose which shortcuts to create.
3	 Click Finish when you’re done.

SSMHD main screen
Open SSMHD to see the screen below. 

Figure 31. SSMHD main screen

Note. You must have 
administrator rights 
to install the program, 
as well as Microsoft 
.NET Framework 
version 3.5.
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Changing the software language

Figure 32. Language selection

1	 Click the globe icon in the lower left corner.
2	 A window will appear. Choose your desired language from the drop-

down menu.
3	 Click OK.

Changing the software size
Click one of the three boxes at the bottom of the screen to choose 
between the small, medium and large display sizes.
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5
   Connecting to a Sensor

 SSMHD communication basics

Figure 33. Connect button, main screen

SmartSensor Manager can connect to your sensors via a serial (RS-
232 or RS-485) or Internet (IP address) connection; this may require 
additional equipment. Th ere is also a virtual option for testing or demo 
purposes. 
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Making a serial connection

Figure 34. Serial connection screen

1	 Click the serial connector icon on the Connect button of the main 
screen.

2	 From the Port drop-down, choose the COM port on your computer 
that the sensor is plugged into.

3	 From the Speed drop-down, choose 9600 bps (the default rate for 
the SmartSensor HD), unless you have previously changed the baud 
rate of the sensor.

4	 Click Connect.

Advanced serial connection settings
˿˿ Flow Control – This should be set to None. You would want to 

change this to Hardware if you’re connecting through a device that 
uses RS-232 hardware handshaking (some older devices require flow 
control handshaking because they cannot keep up with the data rates 
of higher-performance devices).

˿˿ Timeout – This is how long the software tries to connect to the 
sensor before it gives up. You can increase this time if you’re having 
trouble connecting to the sensor.

˿˿ Installation Type – If there is only one sensor on the bus, leave this 
set to Isolated Sensor. If your connection can see several sensors 
(they’re all on a single bus, for example), set this to Multi-drop Net-
work and enter the sensor ID of the sensor you want to connect to.

Note. If you are 
unsure of your port or 

speed, use Search and 
it will cycle through 

all available COM 
ports or baud rates.

Note. You may 
need a USB to serial 

adapter to connect 
to your computer.



Chapter 5:  Connecting to a Sensor  •  35

Making an Internet connection

Figure 35. Internet connection screen

1	 Click the cloud icon on the Connect button of the main screen.
2	 Under Network Address, enter the IP address of the terminal server 

(such as a serial to Ethernet converter or a cellular modem) that the 
sensor is connected to. Do the same with the port number in the 
Port field.

3	 Click Connect.

Advanced Internet connection settings
˿˿ Timeout – This is how long the software tries to connect to the 

sensor before it gives up. You can increase this time if you’re having 
trouble connecting to the sensor.

˿˿ Installation Type – If there is only one sensor connected to the ter-
minal server, leave this set to Isolated Sensor. If the terminal server 
can see several sensors, set this to Multi-drop Network and enter 
the sensor ID of the sensor you want to connect to.

Note. The 
SmartSensor HD is 
not a native IP device. 
Therefore, connecting 
via the Internet 
requires a terminal 
server, such as  a Click 
301 serial to Ethernet 
converter in the 
cabinet, or an external 
modem to put it on 
a cellular network.
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Making a virtual connection

Figure 36. Virtual connection screen

1	 Click the folder icon on the Connect button of the main screen.
2	 Under Virtual Sensor File, click the magnifying glass icon to navi-

gate to the virtual sensor file you want on your hard drive. You can 
also create a new virtual sensor file in the window that pops up by 
navigating to the desired save location, typing in a new file name, 
and clicking OK.

3	 If you want to change the simulated traffic, use the three settings 
under Traffic Properties: to change the style, flow, and average 
speed of the traffic.

4	 Click Connect.

About virtual sensor files
If you make changes to the sensor’s setup while using a virtual connec-
tion, those changes are saved to the virtual sensor file, which by default  
will be saved to C://ProgramFiles/Wavetronix/SmartSensorManagerHD 
vX.X.X/bin/. 

If you want, you can back up those virtual sensor settings; that will 
create a sensor setup file which can then be restored to an actual sensor. 
More on the backup/restore tools in chapter 10.

Definition. A virtual 
sensor connection lets 

you see simulated 
traffic in SSMHD 
without actually 
being connected 

to a sensor—great 
for demos!
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Troubleshooting a connection
Some or all of the following may help you troubleshoot:

˿˿ Make sure that all power and communication wiring is correct.
˿˿ Check the port settings (baud rate, port ID).
˿˿ Make sure the sensor ID is correct.
˿˿ Make sure the terminal server is configured properly.
˿˿ If a failure occurs repeatedly, contact support@wavetronix.com.

Advanced communication tools
Once you’ve made a connection, the Connect button of the main screen 
should now be animated, with arrows moving past each other, and it 
should now say "Connected."

Viewing connection information

Figure 37. Connection Info window

1	 Click Connected.
2	 This will bring up the Connection Info window, with information 

about the connection status, device (subnet and sensor ID), speed in 
bps, and duration.

Disconnecting from a sensor
1	 Click Connected.
2	 This will bring up the Connection Info window. Click Disconnect.
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Using the address book
Filters address books
Deletes an address book
Imports an address book
Exports an address book

Edits the selected device
Deletes the selected device

Adds device to address book

Figure 38. Address book screen

1	 Click on the book icon at the bottom of the connection screen 
(serial, Internet or virtual).

2	 The address book screen will appear; use the settings pointed out to 
add, edit and delete device connection settings.

Viewing the error log

Figure 39. Error log

1	 Click on the notepad icon at the bottom of the connection screen 
(serial, Internet or virtual).

2	 The error log will be saved to C://ProgramFiles/Wavetronix/Smart-
Sensor Manager HD vX.X.X/bin. It will also open in your default .txt 
editor. If you need to save a copy for troubleshooting purposes, do a 
Save As, as the file will be written over next time you view an error 
log.

Note. The address 
book lets you save 
device connection 

settings for 
future use.

Note. The error log 
can be useful in 

troubleshooting, 
or you may need 

to save it and 
send to support@

wavetronix.com.
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Password-protecting the sensor

Figure 40. Setting a password for your sensor

1	 Click on the key icon at the bottom of the connection screen (serial, 
Internet or virtual). The icon only appears when you’re connected.

2	 Check Enabled to confirm you want to password-protect the sensor.
3	 Enter the new password into the Password field.
4	 Click OK.

If you forget your password

Figure 41. Forgotten Password window

When you’re prompted to enter the password, you’ll see a link you can 
click if you’ve forgotten the password you chose. It tells you to contact 
Wavetronix technical support and what information to give them.

Note. If you do this, 
you’ll have to enter the 
password every time 
you try to connect to 
the sensor, so only set 
a password if you’re 
sure you need one.
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Updating the sensor

Figure 42. Version Control basic screen and detailed screen

1	 If the version of SSMHD doesn’t match the version of the sensor’s 
embedded firmware, then after you click Connect, the Version Con-
trol screen will appear.

2	 If you would like specifics on the mismatch, click the Details >> 
button.

3	 Click Install Upgrade, or, if you prefer not to upgrade at this time, 
click Close. 

Reading the date code

20016505

Year 
(2016)

Month 
(May)

Day 
(5th)

Figure 43. Date code

The firmware numbers can be interpreted according to this date code 
image. The month number is written in hexadecimal, meaning that 
October will be written as A, November as B, and December as C.
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Downgrading the sensor

Figure 44. Downgrade warning message

If the downgrade message appears, it means that the sensor firmware is 
newer than the version of SSMHD you’re using. Get the newest version 
of SSMHD from www.wavetronix.com.
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 6
 Configuring  Sensor Settings

Figure 45. Settings button, main screen

Access the sensor settings by clicking Settings on the main screen. 
Changing these settings is optional; if you leave them set to their 
defaults, the sensor will still function.
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Changing General tab settings

Figure 46. General tab

Setting Description Details
Serial Number Shows the identification 

number assigned to the 
sensor by Wavetronix.

Can’t be changed.

Subnet/ID Subnet: defaults to 000.
ID: defaults to the last 
five digits of the sensor 
serial number. No two 
sensors should have the 
same ID.

Subnet: change if 
you want to create 
groupings of sensors.
ID: generally you won’t 
need to change this.

Description Lets you create a 
description of the 
sensor. Limit of 32 
characters.

Change this if you 
think you’ll find it 
useful in identifying the 
sensor later.

Location Lets you enter the 
sensor’s location. Limit 
of 32 characters. 

Change this if you 
think you’ll find it 
useful in identifying the 
sensor later.

Orientation Lets you mark which 
direction the sensor is 
pointing.

Change this if you 
think you’ll find it 
useful in identifying the 
sensor later.
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Setting Description Details
Units Sets whether the 

software displays 
distances in  
standard (mph/feet), 
metric (kph/meters), or 
UK (mph/meters).

Purely for your 
convenience—does 
not affect sensor 
performance.

Date & Time Shows the date and 
time stored on the 
sensor’s internal clock. 
The sensor stores 
time in Coordinated 
Universal Time (UTC) 
and doesn’t account for 
daylight saving time. 
The software uses the 
local settings of the 
computer it’s running 
on to display the date 
and time in local units.

You can change these or 
synchronize the sensor 
to your computer.

Changing Ports tab settings

Figure 47. Ports tab
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Setting Description Details
RS-485

Border Shows which comm link the 
SSMHD is connected to.

If there's a green border 
around this section, 
SSMHD is communicating 
over the RS-485 line.

Speed Lets you change the baud 
rate for this comm link.

All Wavetronix devices 
default to 9600 bps.

Response 
Delay

Lets you set how long the 
sensor will wait before 
responding to a received 
message, shown in 
milliseconds. Default is 10 
ms.

Change this if you’re using 
a communication device 
that can’t quickly change 
transmission direction.

Termination Electronically turns RS-485 
communication bus 
termination on or off.

You don’t need to change 
this unless a multi-drop bus 
becomes overloaded.

RS-232

Border Shows which comm link the 
SSMHD is connected to.

If there's a green border 
around this section, 
SSMHD is communicating 
over the RS-232 line.

Speed Lets you change the baud 
rate for this comm link.

All Wavetronix devices 
default to 9600 bps.

Response 
Delay

Lets you set how long the 
sensor will wait before 
responding to a received 
message, shown in 
milliseconds. Default is 10 
ms.

Change this if you’re using 
a communication device 
that can’t quickly change 
transmission direction.

HW 
Handshaking

Turns on and off flow 
control hardware 
handshaking.

You may need this if you 
connect your sensor to 
certain RS-232 devices 
(like some modems) that 
can’t keep up with the data 
rates of high performance 
devices.
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Changing Outputs tab settings

Figure 48. Outputs tab

Setting Description Details
Source Lets you choose where 

SSMHD gets the traffic data 
it reports.

Choose Antenna for 
standard use (reports data 
as detected by the sensor). 
Choose Diagnostic for 
testing and training (creates 
simulated traffic).

RF Channel Lets you change which 
radio frequency channel the 
sensor is transmitting on.

If you’re using multiple 
sensors within 70 feet of 
each other, set each to its 
own RF channel.

Loop Emulation

Size &
Spacing

Makes your system emulate 
a system with inductive 
loops. These settings are 
read by a Click contact 
closure device, which uses 
that information to send 
contact closures that are 
properly timed to emulate a 
given loop size and spacing.

Use this if you used the 
SmartSensor HD to replace 
loops, and the rest of your 
system is still configured to 
deal with loops. This way 
the system keeps getting the 
sort of data it expects to see.

Note. Changing 
loop size will affect 
occupancy numbers 

in the interval 
data, but adjusting 
these settings will 

not modify the 
reported vehicle 
length or speed.
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Setting Description Details
Legacy Protocols

SS105 Sets the sensor to use the 
SS105 communication 
protocol.

This doesn’t turn off native 
SSHD protocol.

Click this checkbox if 
your backend system was 
originally configured for 
a SmartSensor 105 and is 
still expecting data in SS105 
protocol.

RTMS (X3) Sets the sensor to use the 
RTMS communication 
protocol (although only 
a portion of the RTMS 
commands are emulated).

This doesn’t turn off native 
SSHD protocol.

Click this checkbox if your 
controller or backend 
system was originally 
configured for an RTMS 
model X3 sensor and is still 
expecting data in RTMS 
protocol.

Changing Data tab settings

Figure 49. Data tab

Setting Description Details

Max Vehicle 
Length

Lets you set your maximum 
vehicle length; any detected 
vehicle that exceeds this 
length is reported as being 
only this long.

Change this if your roads 
have a max vehicle length.

Note. For a 
SmartSensor HD 
in an RTMS-based 
system: if your system 
is set up to poll the 
sensor, turn on the 
RTMS protocol so the 
sensor can respond 
to RTMS commands. 
If your system is 
simply listening for 
data pushes from the 
sensor, don’t turn on 
the RTMS protocol.
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 7
   Configuring Lanes

Figure 50. Lanes button, main screen

Click the Lanes button on the main screen to open the Lanes screen, 
then click the Confi guration button to open the Confi guration screen.
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Figure 51. Lanes screen

 Alignment

Sidebar

Sidebar button View menu

Alignment arrow

Figure 52. Alignment tools
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Checking sensor alignment

Figure 53. Good, mediocre, bad, and very bad alignment (left to right)

1	 Be sure traffic is flowing freely on the road in order to get this tool to 
work best.

2	 If you don’t see the alignment arrow, open the View menu by click-
ing the magnifying glass icon, then select Show Alignment.

Figure 54. View menu

3	 If you don’t see the alignment sidebars, click the >> button on either 
side of the screen until the number 1 is displayed. 

4	 Watch the arrows to see where the sensor’s alignment is at.
5	 Move the sensor manually to fix it. Give the software a few moments 

after each sensor movement to adjust; a few vehicles need to pass by 
before it can report on the new alignment.

6	 If you’d like, hide the arrow again using the View menu.

Troubleshooting the alignment tool
˿˿ The software needs a few vehicles to pass before it can start getting a 

read on the alignment. If you’re having trouble, there might not be 
enough traffic on the road; wait until more vehicles have passed, or 
get in your own vehicle and drive in front of the sensor a few times.

˿˿ You may need to reset the alignment if there has been a drastic 

Note. Lane 
configuration won’t 

work as well as it 
should if the sensor 

is misaligned, so 
don’t skip this step! 

Note. The large arrow 
in the center shows 

the average alignment 
of all lanes; the small 

arrows in the sidebars 
show the alignment 

in each lane.  
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change to the sensor’s position.
˿˿ It can be difficult to align if there are non-parallel lanes of traffic 

(such as freeway ramps) in front of the sensor. Mark the non-parallel 
lanes as Inactive or Excluded (covered in the next section) until the 
alignment is taken care of.

Lane configuration

Sidebar

Sidebar button View menu 
Tools menu

Roadway

Shoulder area

Figure 55. Configuration screen

Capturing lanes

Figure 56. Automatic Lane window

Note. There must be 
traffic on the road 
for the automatic 
configuration process 
to work. If there’s no 
traffic on the road, you 
may need to drive your 
own vehicle back and 
forth in front of the 
sensor a few times.
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1	 Open the Tools menu by clicking the hammer and wrench icon, then 
select Clear Edit Area.

2	 Click on the sidebar button until sidebar 1 appears.
3	 Open the Tools menu again and select Restart Auto Cfg.
4	 Let the configuration process run (this could take a few seconds to a 

few minutes) until all of the lanes have been found by SSMHD; they 
will appear as blue bars in the sidebar and, if Show Auto Lanes is 
turned on, in the edit area.

5	 If the software’s set to Show Auto Lane, change it: open the View menu 
by clicking the magnifying glass icon, and select Hide Auto Lanes; 
the automatically detected lanes will disappear from the edit area.

6	 If you want to capture all the lanes that appear in the sidebar, 
click anywhere in the sidebar; in the Automatic Lane window that 
appears, click Copy Sidebar. If you only want to capture certain 
lanes, click on those lanes in the sidebar; in the Automatic Lane 
window that appears, click Copy Lane. Repeat as needed. Captured 
lanes will appear black.

Excluding or including a lane or area

Figure 57. Lane window

1	 Click on the lane or shoulder area you want to exclude. The Shoul-
der Area window or Lane window will appear, based on which you 
clicked.

2	 Click the Exclude button. 
3	 To include an area that has previously been excluded, click on it to 

open this window again, and click Include.

Note. Excluding a 
lane or area is useful 
when you’re aligning 
the sensor and there 

are non-parallel lanes 
that are making the 

alignment difficult. It 
can also stop events 

from being generated 
in any non-lane areas.
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Adding a lane

Figure 58. Shoulder Area window

1	 Click on the spot where you want to add a lane. The Shoulder Area 
window will appear.

2	 Click Add Lane. The new lane will appear black, unlike a blue auto-
matically configured lane.

Editing a lane name

Figure 59. Lane window

1	 Click on the lane you want to edit. The Lane window will appear.

Note. Other options 
found in the Lane 
window will be covered 
later in this chapter.

Note. The software 
won’t let you use 
“LANE_xx” as the 
format (since that’s 
the format it uses), 
but you can use the 
lowercase version, 
“Lane_xx”, if you’d like.
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2	 Change the Name field at the top.
3	 Click the X in the upper right corner to save and close the window.

Deleting a lane
1	 Click on the lane you want to delete. The Lane window will appear.
2	 Click Delete. Be aware that if the lane was automatically configured, 

and if Show Auto Lanes is turned on, once it is deleted it will still 
appear as a blue automatic lane. 

Saving the configuration
Any of the following will save the configuration:

˿˿ Click OK.
˿˿ Click on the gray dot under the sensor for a shortcut to the Verifica-

tion screen.

Either of these will cause a prompt to appear, asking if you want to save. 
Click Yes.

Sidebars, menus and windows

Sidebar

Sidebar button Sidebar button
View menu
View menu

Vehicle Display menu Tools menu

Figure 60. Tools for accessing menus and windows

The following section outlines all options available in the various side-
bars, menus and windows accessible from the Configuration screen. 
Some of these change software functionality, while others simply change 
how things are displayed.
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Viewing sidebars

Figure 61. Sidebar options

The sidebars appear on either side of the screen and give information 
about the lanes and shoulder. Click the sidebar button to cycle through 
the six sidebar options.

Setting Description Details
>>
(off)

No sidebar shown. N/A

1
(Automatic 
configuration)

Shows the lanes that 
have been automatically 
configured by the sensor, 
in blue.

Use this to save only certain 
automatically configured 
lanes to the sensor, as 
discussed under Automatic 
Configuration. Or use the 
automatically configured 
lanes as a reference—to 
see where the software has 
calculated that the lanes 
are—while you’re manually 
configuring or adjusting 
lanes.

2
(Saved 
configuration)

Shows the lanes that have 
been saved, in black.

Use the lanes currently 
saved to the sensor as a 
reference—to see where 
the lanes have previously 
been saved at—while you’re 
manually configuring or 
adjusting lanes.
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Setting Description Details
3
(Scale)

Shows a ruler indicating 
distances, in feet or meters, 
from the sensor. You can 
click on this sidebar to see 
a pop-up window showing 
the spot you clicked’s 
distance from the sensor.

Use this to measure how 
far lanes or events are from 
the sensor, or to determine 
where to place manual 
lanes.

4
(Centers)

Shows the relative center 
of a lane, based on the 
occurrence of detections; 
the more vehicles are 
detected at a given range, 
the larger the arrow-shaped 
indicators become. For best 
results, you’ll need to let 
this run for a few minutes.

Use this to get a sense of 
where vehicles are most 
often being detected, which 
can be useful for verifying 
lane placement or manually 
adding lanes.

5
(Tracks)

Shows a thin line for each 
vehicle that passes; as more 
vehicles pass in a given 
spot, the lines will pile up 
to make thicker lines. You 
can click on this sidebar to 
clear all tracks and restart 
accumulating them.

Use this to get a sense of 
where vehicles are most 
often being detected, which 
can be useful for verifying 
lane placement or manually 
adding lanes.

Note. The difference 
between centers and 

tracks is that tracks 
accumulate more 

quickly, but also more 
quickly become solid 

bars, showing only 
the lane’s placement. 

Centers accumulate 
more slowly, but 

you can get more 
precise information 
about frequency of 

vehicle detection 
at a given range 

for a longer time.
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Using the Automatic Lane sidebar window

Figure 62. Sidebar 1 (automatic configuration) window

When sidebar 1 (automatic configuration) is open, click on one of the 
lanes in the sidebar to open this window.

Setting Description Details
Range &
Width

Shows the size and 
placement of the lanes 
(Range refers to the 
distance from the sensor).

Can’t be changed.

Copy Lane Saves the lane you clicked 
on to the edit area.

An automatic lane will 
appear blue; a saved lane 
turns black.

Copy Sidebar Saves all the lanes currently 
shown in the sidebar to the 
edit area.

This is the recommended 
method for saving 
automatically configured 
lanes to your configuration.

Pause Auto 
Config

This temporarily halts the 
automatic configuration 
process; no new lanes will 
be placed until you click 
again to resume.

Use this if, during the 
configuration process, 
there are traffic events you 
don’t want to be part of the 
sensor’s calculations.

Sidebar 1 shoulder area window
If you click the shoulder area, instead of a lane, it will open a window 
with just the range/width of the shoulder and the Copy Sidebar option.
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Using the Saved Lane sidebar window

Figure 63. Sidebar 2 (saved configuration) window

When sidebar 2 (saved configuration) is open, click on one of the lanes 
in the sidebar to open this window.

Setting Description Details
Direction Shows the direction of 

traffic, as it’s been detected 
by the sensor. 

Can’t be changed here, but 
can be changed in the Lane 
window.

Range &
Width

Shows the size and 
placement of the lanes 
(Range refers to the 
distance from the sensor).

Can’t be changed here, but 
can be changed in the Lane 
window.

Copy Lane Saves the lane you clicked 
on to the edit area.

An automatic lane will 
appear blue; a saved lane 
turns black.

Copy Sidebar Saves all the lanes currently 
shown in the sidebar to the 
edit area.

This is the recommended 
method for saving 
automatically configured 
lanes to your configuration.

Sidebar 2 shoulder area window
If you click the shoulder area, instead of a lane, it will open a window 
with just the range/width of the shoulder and the Copy Sidebar option.
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Using the Vehicle Display menu

Figure 64. Choosing vehicle display options

Click the vehicle display button (dark blue car on a teal background) to 
change how the detected vehicles are displayed.

Setting Description Details
Display 
vehicles by:

Determines where detected 
vehicles are displayed:
Range (the default) means 
the vehicles are displayed 
exactly where they’re 
detected. Lane means the 
vehicles are displayed in the 
center of their lane, even if 
they’re actually closer to the 
lane’s edge than shown.

Range is more useful as an 
accurate depiction of what’s 
being detected, and for 
detecting anomalies such as 
multipathing. Lane is more 
useful for demonstration 
purposes, to show sensor 
functionality.

Display 
vehicle:

Lets you choose what 
number is displayed atop 
the teal boxes representing 
a detection: the vehicle’s 
speed, its length, or the 
length class bin it falls into 
(class will be grayed out if 
no class bins are currently 
configured; learn how to 
configure them in chapter 
9). Speed is the default.

If you’re comparing vehicle 
detections with observed 
vehicles out on the road, 
to check for accuracy, you 
may find it useful to be 
able to view different sorts 
of information about the 
detections, based on what 
you’re currently observing 
on the road.

Note. You must have 
length classification 
bins set up in order to 
select the class option 
here. If you don’t have 
them set up, class will 
be grayed out in this 
menu. See chapter 9 
to set up these bins.
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Using the Tools menu

Figure 65. Tools menu

Click the hammer and wrench icon to open the Tools menu.

Setting Description Details
Undo Last 
Edit

Undoes the last edit 
undertaken in the edit area.

N/A

Clear Edit 
Area

Clears all captured and 
manually created lanes from 
the edit area. Does not clear 
automatically configured 
lanes, however.

Automatically configured 
lanes only disappear if you 
choose Hide Auto Lanes 
from the View menu or 
Automatic Lane window. 
Even then, they’re not 
deleted, just hidden.

Save To File & 
Load From 
File

Let you save lane 
configuration information 
to a file on your computer, 
and then load from that file 
back to SSMHD.

Use these if you’re replacing 
an old HD with a new one 
and don’t want to do the 
whole configuration process 
again. You can save from 
the old sensor, put up the 
new one, and load it with 
the lane information.

Restart Auto 
Cfg

Begins the automatic 
configuration process over.

N/A

Reset 
Alignment

Begins the alignment check 
process over.

N/A

Note. This only saves 
lane configuration 

settings to file. Saving 
all configuration 

settings to file is 
covered in the Tools 

chapter of this guide.
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Using the View menu

Figure 66. View menu options

Click the magnifying glass icon to display the View menu.

Setting Description Details
Show/Hide 
Auto Lanes

Shows or hides the blue 
automatically configured 
lanes (those that haven’t 
been saved yet).

This is one step in the 
process of saving only a 
portion of the automatically 
configured lanes; see the 
Lane Configuration section 
of this chapter for details. 
Hiding automatic lanes can 
also be done through the 
Automatic Lane window.

Show/Hide 
Lane Names

Changes the display of the 
text on the lanes.

This setting is for your 
convenience and doesn’t 
affect sensor operation.

Show/Hide 
Direction

Changes the display of the 
arrows on the lanes.

This setting is for your 
convenience and doesn’t 
affect sensor operation.
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Setting Description Details
Show/Hide 
Compass

Shows or hides a compass 
that shows which direction 
the sensor is pointing. This 
is completely user-set; the 
information comes from 
the Orientation field under 
Settings, so if you didn’t 
change that setting, this will 
default to north. You can 
change the orientation by 
clicking on the compass. 

This setting is for your 
information and doesn’t 
affect sensor operation.

Show/Hide 
Alignment

Shows or hides the arrow 
used for indicating the 
alignment of the sensor.

See the Alignment section 
earlier in this chapter for 
more information.

Using the Automatic Lane window

Figure 67. Automatic lane window

Click an automatic lane in the edit area to open this window.

Setting Description Details
Range &
Width

Shows the size and 
placement of the lanes 
(Range refers to the 
distance from the sensor).

Can’t be changed.



Chapter 7:  Configuring Lanes  •  63

Setting Description Details
Hide Auto 
Lanes

Hides (but does not 
delete) the automatically 
configured lanes from the 
edit area.

This can also be done 
through the View menu.

Capture Saves the lane you 
clicked on to the sensor’s 
configuration.

When captured, the lane 
will turn from blue to black. 
This can also be done by 
clicking on the automatic 
configuration sidebar.

Exclude Tells the sensor to ignore 
the lane; detections in the 
lane won’t affect alignment 
or configuration. To include 
the area again, click it to 
open the Excluded Area 
window and click Include.

An excluded lane behaves 
like a deleted lane; the 
difference is that an 
excluded lane can easily 
be included again, while a 
deleted lane will have to be 
reconfigured. An excluded 
area will turn red.

Using the Lane window

Figure 68. Lane window

Click a saved (black) lane in the edit area to open this window.
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Setting Description Details
Name Lets you type in a new lane 

name.
SSMHD uses “LANE_xx” 
as the default (“xx” is the 
number of the name, with 
LANE_01 nearest the 
sensor). When you add a 
new lane, all lanes with this 
name format will be updated.

For RTMS and Z4 data 
push, lane mapping may be 
changed using the notation
#xx (“xx” being a lane 
number). All lanes must use 
this format for the new lane 
mapping to take effect.

Active Lets you set a lane status as 
active or inactive.

You might set a lane inactive 
when it’s been correctly 
configured and tuned, 
but you don’t need data 
reporting for it right now. By 
making it inactive instead 
of deleting it, you can easily 
turn it on later if needed.

Direction Sets the direction for the 
lane. Choose between Left, 
Right and Bi-direction. 
Left and Right refer to the 
direction that the traffic is 
moving toward, relative to 
the sensor.

(If you choose Bi-direction, 
then Direction Protection, 
a setting found on the 
Verification screen, will be 
disabled.)

Choose Left or Right 
depending on the direction 
the traffic is moving. (If 
Direction Protection is 
turned on, then choosing 
Left or Right here will help 
the sensor detect wrong-
way vehicles, and they 
will not be counted by the 
sensor—though they will 
still appear.)

If you set it to Bi-direction, 
data will be reported for 
traffic going both directions 
(useful for lanes that change 
direction at certain times 
of day, such as those that 
change to match commuter 
traffic at the beginning and 
end of the work day).

Note. If you decide 
to renumber the 

lanes manually, the 
software won’t let 

you use “LANE_xx” 
as the format, but 

you can use the 
lowercase version, 

“Lane_xx”, if you’d like.

Note. Wrong-way 
detections are reported 

as having negative 
speeds. If a lane is set 

as bi-directonal, traffic 
in both directions is 
reported as having 

positive speeds.
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Setting Description Details
Range &
Width

Shows and changes the 
size and placement of the 
lane (Range refers to the 
distance from the sensor).

Change these values with 
the arrows or by typing in 
order to manually fine-
tune your lane placement. 
Be aware that changing 
these may cause other 
lanes to change size or even 
disappear.

Delete Deletes the selected lane. If you only want the 
selected lane to temporarily 
disappear or to be ignored, 
consider excluding or 
deactivating the lane 
instead; this will make it 
possible to easily recover 
the lane without having to 
reconfigure it. 

Exclude Tells the sensor to ignore 
the lane; detections in the 
lane won’t affect alignment 
or configuration. To include 
the area again, click it to 
open the Excluded Area 
window and click Include. 
(The lane may reappear as 
an automatic lane; click on 
it to capture it.)

An excluded lane behaves 
like a deleted lane; the 
difference is that an 
excluded lane can easily 
be included again, while a 
deleted lane will have to be 
reconfigured. An excluded 
area will turn red.
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Using the Shoulder Area window

Figure 69. Shoulder Area window

Click in the shoulder (tan) area to open this window.

Setting Description Details
Range &
Width

Shows the size and 
placement of the lanes 
(Range refers to the 
distance from the sensor).

Can’t be changed.

Hide Auto 
Lanes

Hides (but does not 
delete) the automatically 
configured lanes from the 
edit area.

This can also be done 
through the View menu.

Add Lane Creates a new lane in the 
spot you clicked on.

Unlike automatically 
configured lanes, which are 
blue when they first appear,  
user-created lanes will 
appear black.

Exclude Tells the sensor to ignore 
the area you clicked on; 
detections there won’t affect 
alignment or configuration. 
To include the area 
again, click it to open the 
Excluded Area window and 
click Include.

This may be useful 
in order to ignore 
phantom detections from 
multipathing. An excluded 
area will turn red.
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Using the Excluded Area window

Figure 70. Excluded Area window

Click any excluded (red) area, either shoulder or lane, to open this 
window.

Setting Description Details
Range &
Width

Shows and changes the 
size and placement of the 
excluded area (Range refers 
to the distance from the 
sensor).

Change these values with 
the arrows or by typing in 
order to manually fine-
tune your lane placement. 
Be aware that changing 
these may cause other 
lanes to change size or even 
disappear.

Include Area Restores the area or 
lane that was previously 
excluded.

When you include a 
lane that was previously 
excluded, it may reappear as 
an automatic lane; click on 
it to capture it.
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 8
   Verifying Lanes

Figure 71. Lanes button, main screen

Click the Lanes button on the main screen to open the Lanes screen, 
then click the Verifi cation button to open the Verifi cation screen.
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Figure 72. Verification screen

 Verification options

Sidebar button

Play/pause/stop buttons

 SidebarVehicle Display menu

Per Vehicle Data 

Vehicle Display menu

Figure 73. Lane verification tools

Verifying lanes means comparing the detection data in the SSMHD soft -
ware with the actual traffi  c in the roadway; you can observe the roadway 
traffi  c yourself, or record it using a separate device. If the actual traffi  c 
matches the soft ware traffi  c, your lanes are set up properly.

 Verifying lanes  using vehicle display options
1 Set up a way to observe on-road traffi  c: seat yourself in a place where 
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you can see both the road and the computer, or have someone else 
observe traffic for you while you monitor your computer.

2	 Click the vehicle display icon (dark blue car on a teal background). 
The Display vehicle: menu will appear.

3	 Choose speed, length or class to choose which of these will appear 
on top the detections (the detections appear as teal rectangles 
moving across the screen).

4	 Compare the detections on the software, with their speed, length 
or class information, with what is observed in the roadway. If they 
match, the lanes are set up properly.

If the detections don’t match traffic
You may be able to improve accuracy by adjusting lane properties and 
thresholds (covered later in this chapter), double-checking the alignment 
(covered in the previous chapter), or changing the mounting locations. If 
all else fails, contact your dealer or support@wavetronix.com.

Verifying lanes using sidebars
1	 Set up a way to observe on-road traffic: seat yourself in a place where 

you can see both the road and the computer, or have someone else 
observe traffic for you while you monitor your computer.

2	 Click the sidebar button until the desired sidebar appears; sidebar 
option definitions are as follows:

Setting Description Details
>>
(off)

No sidebar shown. N/A

Pre
(Presence)

Shows a button that lights 
up red when a vehicle is 
detected crossing in front of 
the sensor.

Choose this if you want to 
confirm that the sensor is 
detecting the vehicles. 

Vol
(Volume)

Shows a growing tally of 
how many vehicles have 
been detected in each lane.

Choose this to check that 
the sensor is detecting 
vehicles over a longer 
period of time.

Definition. “Class” 
refers to length 

classification bins. 
You must have length 
classification bins set 

up in order to select 
the class option here. 

If you don’t have them 
set up, class will be 

grayed out in this 
menu. See chapter 9 
to set up these bins.
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Setting Description Details
Spd
(Speed)

Shows the constantly-
updated average speed of 
vehicles detected in each 
lane.

Choose this to check that 
the sensor is detecting 
speeds correctly. If you’d 
prefer a per vehicle speed, 
rather than an average, use 
the Vehicle Display menu.

C
(Class)

Shows a growing tally of 
how many vehicles of a 
given length class have been 
detected in each lane.

These sidebars only appear 
if classes have been set up 
on the Definitions screen. 
There will be one sidebar 
for each class (C1, C2, etc.).

3	 Compare the information in the sidebar with what’s being detected 
on the roadway. It’s easiest to do this one lane at a time. For instance, 
you could manually count all vehicles that pass in lane 1 in a set 
period of time, then check to see if the volume counts match your 
counts. If they match, the lanes are set up properly.

4	 Repeat with all lanes, and, if desired, other sidebar options.

If the detections don’t match traffic
You may be able to improve accuracy by adjusting lane properties and 
thresholds (covered later in this chapter), double-checking the alignment 
(covered in the previous chapter), or changing the mounting locations. If 
all else fails, contact your dealer or support@wavetronix.com.

Using the play/pause/stop buttons
You may find it useful to use these buttons to pause or restart the speed 
and volume counts on the sidebars. For instance, using the example in 
step 3 above, you could do the following:
1	 Open the volume sidebar, then click the stop button to stop the 

counts.
2	 Once there is a large gap in the traffic in lane 1, click the play button. 

This will restart the counts at 0.
3	 Count vehicles in lane 1 manually until there is another large gap in 

the traffic.
4	 Click the pause button. Now you know the volume counts in the 

sidebar precisely reflect the traffic that passed between those two 
gaps, and you don’t have to hurry to compare your counts before 
another vehicle passes and messes it up.

Note. For this to be a 
useful way to verify 
detections, you need 
a way to measure or 
estimate the speeds 
of the vehicles on 
the roadway.
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Verifying lanes using per vehicle data

Figure 74. Per Vehicle Data screen

1	 Set up a way to observe on-road traffic: seat yourself in a place where 
you can see both the road and the computer, or have someone else 
observe traffic for you while you monitor your computer.

2	 Click on the paper icon to open the Per Vehicle Data screen. This 
will open in a full-sized screen that covers the Lane Verification 
screen, but you can drag it to the side if you want to observe both at 
once.

3	 Compare the information on this screen with what’s being detected 
on the roadway. It’s easiest to do this one lane at a time. For instance, 
you could use a radar gun to track speeds of vehicles in lane 1, and 
check on this screen to see if the sensor’s detected speeds match the 
actual vehicle’s speeds. If they match, the lanes are set up properly.

4	 Repeat with other lanes and other criteria, as needed.

If the detections don’t match traffic
You may be able to improve accuracy by adjusting lane properties and 
thresholds (covered later in this chapter), double-checking the alignment 
(covered in the previous chapter), or changing the mounting locations. If 
all else fails, contact your dealer or support@wavetronix.com.

Using the play/pause/stop buttons
You may find it useful to use these buttons to pause or restart the per 
vehicle data being constantly updated on this screen.

˿˿ The pause button will cause the screen to stop being updated; when 

Note. This option is 
similar to using the 

sidebar or the Vehicle 
Display menu; the 
biggest difference 

is that you get 
much more detailed 
information—this is 
the only way to see 

timestamps and 
ranges of detections.
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you hit play again, it will resume.
˿˿ The stop button will also stop the screen from being updated, but 

when you hit play, all previous detections will be deleted.

Verifying lanes using logging

Figure 75. Log File window

1	 Set up a way to record what’s happening on the road, such as a video 
camera or someone with a speed gun manually recording passing 
vehicles.

2	 In the lower right corner of the Verification screen, next to the word 
“Logging,” click the upward-pointing arrow. The Logging area will 
appear, as seen above.

3	 Choose where to store the log file by clicking the folder icon. If you 
want to change the location shown in the window that opens, click the 
magnifying glass icon next to the file name. (If you create a new file, 
add a .csv file extension to the end of the filename.)

4	 Click OK when done.
5	 To begin logging, click the switch icon. When you’re done, click it 

again to stop. Record the traffic that passes on the road during the 
same interval.

6	 To view the file, click on the folder icon, and then the magnifying 
glass icon at the bottom of the window that opens. You can also nav-
igate to the file on your computer: C://ProgramFiles/Wavetronix/
SmartSensor Manager HD vX.X.X/bin. The file that was created will 
be a .csv spreadsheet that can be opened in Microsoft Excel.

7	 Compare the logged data to what was detected on the roadway. If 
they match, the lanes are set up properly. 

Note. This tool records 
per vehicle data and 
saves it to a file. It’s 
useful for verification 
after the fact; you 
record the traffic, log 
the per vehicle data for 
the same interval of 
time, and then you can 
compare the two later.
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If the detections don’t match traffic
You may be able to improve accuracy by adjusting lane properties and 
thresholds (covered later in this chapter), double-checking the alignment 
(covered in the previous chapter), or changing the mounting locations. If 
all else fails, contact your dealer or support@wavetronix.com.

Lane adjustment

Lane Adjustment window

Figure 76. Other tools

Adjusting lane properties and thresholds
1	 Click on the lane you wish to adjust (you can only adjust one at a 

time.) The Lane Adjustment window will appear.
2	 Choose the desired property from the drop-down menu.

Note. These settings 
allow you to try to fix 
problems you noticed 

during the verification 
process. If adjusting 

these doesn’t fix your 
problem, contact your 

dealer or support@
wavetronix.com.
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Setting Description Details
Volume Adjusts the aggressiveness 

of traffic radar–specific 
algorithms.

Adjust this setting if you 
observe a count accuracy 
problem. Adjust the 
percentage up to increase 
the number of detections 
and down to decrease.

You’ll likely need to adjust 
at least 10–15% in either 
direction (possibly much 
more); adjusting less may 
not impact detections. We 
recommend you keep the 
slider between 20 and 190%. 

Detection Raises or lowers the 
thresholds for detecting 
vehicles. It lets you 
determine how large a radar 
return must be in order for 
the software to define it as a 
vehicle detection.

Adjust this setting if you’re 
having a problem with 
multipathing—by raising it 
a little, you may be able to 
weed out false detections. 
But raising it too high will 
begin to weed out real 
detections as well.

Increasing the decibels 
raises the threshold and 
results in fewer detections; 
decreasing lowers the 
threshold and results in 
more detections. 

Speed Raises or lowers the speed 
calculated for all vehicles in 
each lane.

Adjust this setting if speeds 
are consistently too high or 
too low. After you enter a 
value, the sensor calculates 
the speed of each detection 
and then multiplies it by 
your entered value.

Length Increases or decreases the 
length calculated for all 
vehicles in each lane.

Adjust this setting if lengths 
are consistently too big or 
too small. After you enter a 
length, the sensor calculates 
the length of each detection 
and then adds or subtracts 
your entered value to it.

Note. Each of these 
settings affects only 
the lane you clicked on.

Note. Since the 
occupancy metric 
reported in the interval 
data is calculated 
using length, a change 
in this parameter 
will also change the 
reported occupancy.
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Setting Description Details
Extension 
Time

Increases or decreases the 
extension time, which the 
sensor uses to prevent 
vehicles with trailers from 
being broken up into 
multiple detections.

Adjust this setting if 
the sensor seems to be 
mishandling detections 
of vehicles with trailers. 
Increasing the extension 
time will help make sure 
such vehicles aren’t counted 
as multiple detections, 
but too much can lead to 
multiple vehicles being 
detected as a single vehicle.

After you enter a value, 
the sensor automatically 
determines the extension 
time and then multiplies it 
by your entered value.

Direction 
Protection

Determines whether 
the software reports or 
ignores any vehicles that 
are traveling the opposite 
direction in a given lane. 
For example, if this is 
turned on, and if a lane is 
configured as moving left 
to right, then any traffic 
moving right to left will be 
ignored (it won’t be shown 
on the Verification screen—
though it will be shown on 
the Configuration screen—
and it won’t be counted).

By default, Direction 
Protection is turned on for 
each lane (although if you 
set a lane as bi-directional, 
this setting is turned off 
and can’t be turned back 
on from here—you’ll 
have to go back to the 
Configuration screen).

Having it on can be useful 
if, for instance, the sensor’s 
in an area where work 
vehicles often go the wrong 
direction up the road. You’ll 
need it off, however, to do 
wrong-way detection.

Set Defaults Returns all the settings for 
this lane to the defaults.

N/A

3	 Use the slider or the text box to change the value for that property.
4	 Click OK.

Note. There must 
be a minimum of 5.5 

ft. (1.7 m) between 
vehicles in order for 

them to be detected 
as separate vehicles; 

this minimum may 
increase as vehicle 

speeds increase.

Note. If Direction 
Protection is on, 

wrong-way vehicles 
will not be shown 

moving across the 
Verification screen. 
However, they will 

still be shown on the 
Configuration screen.
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 9
 Setting Up and 

Downloading Sensor  Data

Figure 77. Data button, main screen

Click the Data button on the main screen to open the Data screen.
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Figure 78. Data screen

Definitions

Figure 79. Definitions screen

This screen lets you define interval length, bins (class, speed and direc-
tion) and approaches. You can set all, some or none of these definitions 
simultaneously.

How you set these will affect your sensor’s onboard storage—the more 
definitions you have set, the larger the records will be, and the faster the 
onboard memory will fill up.
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Adjusting the data interval
1	 Determine what interval you need for your particular application. 

For example, for real-time applications, you might want to aggregate 
data over short periods of time to reduce reporting latency. On the 
other hand, for a long-term testing site, long intervals could be suf-
ficient for your needs and would mean you don’t have to download 
the data as often.

2	 Type the desired interval time into the Interval text field, or use the 
up and down arrows to change it.

Creating, adjusting and deleting speed bins

Figure 80. Adjusting a speed bin

1	 To create a speed bin, press the + button at the bottom of the Speed 
area. Each line is one bin.

2	 To adjust the parameters of a bin, click on it and use the + and – 
buttons to change the value, or type a new value in. The number 
that you see is the maximum speed for that bin. For instance, in the 
image above, the highlighted bin is for vehicles traveling between 66 
and 85 miles per hour.

3	 To delete a bin, highlight it and click the – button at the top of the 
Speed area.

Definition. Interval 
data is collected for all 
the vehicles that pass 
the sensor in a set 
amount of time (that 
time is called “the 
interval”). A shorter 
interval means the 
sensor records data 
 more often, so onboard 
storage fills up faster. 
A longer interval means 
you can leave the 
sensor alone longer.

Definition. A speed 
bin is a classification 
of a vehicle based 
on its speed (usually 
a range of speeds); 
which speed bin a 
detection falls into 
is part of the data 
collected about it. 
For interval data, the 
sensor records how 
many detections fell 
into each bin over the 
course of the interval.

Note. The first 
speed bin created 
defaults to 145; it is 
the maximum speed 
value and cannot 
be changed. This 
bin can’t be deleted 
until all the others 
are deleted first.
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Creating, adjusting and deleting class bins

Figure 81. Adjusting a class bin

1	 To create a class bin, press the + button at the bottom of the Class 
area. Each line is one bin.

2	 To adjust the parameters of a bin, click on it and use the + and – but-
tons to change the value, or type a new value in. The number that 
you see is the maximum length for that bin. For instance, in the 
image above, the highlighted bin is for vehicles that are between 31 
and 50 feet long.

3	 To delete a bin, highlight it and click the – button at the top of the 
Class area.

Creating, adjusting and deleting approaches

Figure 82. Approaches window

1	 To create a new approach, click the + button at the bottom of the 
Approaches area. The Approaches window will appear.

2	 Type a name for your new approach in the Name field at the top.
3	 From the lanes list on the left, select a lane you want in your new 

approach.
4	 Click the right arrow to move it to the approach list on the right.

Definition. A class bin 
is a classification of 

a vehicle based on its 
length (usually a range 

of lengths); which 
length bin a detection 
falls into is part of the 

data collected about it. 
For interval data, the 

sensor records how 
many detections fell 

into each bin over the 
course of the interval.

Note. The first class 
bin created defaults 

to 120; it is the 
maximum length 
value and cannot 
be changed. This 

bin can’t be deleted 
until all the others 

are deleted first.

Definition. An 
approach is a grouping 

of lanes used in 
data collection; they 

let you collect per 
vehicle–based stats 

you couldn’t get 
otherwise, such as 
85th percentile. Be 
aware that adding 

approaches will 
increase the data 

report size, meaning 
the sensor can store 

fewer intervals in 
onboard storage.
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5	 Repeat for all desired lanes.
6	 To remove a lane from your approach, highlight it in the approach 

list, and click the left arrow to move the lane back to the lanes list.
7	 When you’re done, click OK. Repeat steps 1–6 as needed.
8	 To remove an approach, highlight it and click the – button at the top 

of the Approaches area.

Using direction bins

Figure 83. Direction checkbox

To enable the use of direction bins, click the Direction checkbox in the 
lower righthand corner of the Definitions screen.

Using the Speed = 0 option
If during an interval, the volume is zero (meaning no cars were 
detected), SSMHD will report the average speed of the last interval. If 
you would like the intervals that are reporting zero volume to report 
speeds as zero, simply check the If volume = 0, speed = 0 checkbox.

Interval Data

Figure 84. Interval Data screen, Lanes tab

Note. A lane can 
belong to more than 
one approach.

Definition. There are 
two direction bins: 
Right and Wrong. 
Vehicles are classified 
depending on whether 
they are traveling 
the direction the 
lane is configured. 
For bi-directional 
lanes, traffic moving 
from left to right  
will be placed in the 
Right bin, and traffic 
moving from right 
to left will be placed 
in the Wrong bin.
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Access the Interval Data screen by clicking the Interval Data button on 
the Data screen. This screen lets you log interval data (data collected 
about all detections in a given interval of time) for both lanes and 
approaches.

Figure 85. Interval Data screen, Approaches tab

Logging interval data
1	 In the lower right corner of the Interval Data screen, next to the 

word “Logging,” click the upward-pointing arrow. The Logging area 
will appear, as seen above.

2	 Choose where to store the log file by clicking the folder icon; the Log 
File window will open. If you want to change the location shown, 
click the magnifying glass icon next to the file name.

3	 Click OK when done.
4	 Click the checkboxes of what you want to log: Lanes, Approaches, 

or both. If you don’t click either checkbox, the resulting log file will 
be blank.

5	 To begin logging, click the switch icon. When you’re done, click it 
again to stop.

6	 To view the file, navigate to it on your computer. The file that was 
created will be a .log file that can be opened in a text editor.

Interval data
The Lanes and Approaches screens show the following data about each 
interval that passes (they don’t all fit on the screen, so click and drag 
from side to side to show more data):

Note. Logging interval 
data is useful for 

verifying your sensor 
setup—just log a few 

intervals then compare 
with video or other 

recorded data. Or you 
can use the feature at 

test sites, where you 
just need to examine 

a few intervals’ worth 
of detections.

Note. The Lanes and 
Approaches tabs let 

you view the detected 
data in real time. 

However, which tab 
you have open doesn’t 

affect logging.

Note. Keep this 
screen open while you 

log—if you close it, 
the logging will stop!
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˿˿ Name – Of each lane or approach.
˿˿ Volume – Number of vehicles detected during the interval.
˿˿ Occupancy – Percentage of time, during the interval, that the detec-

tion zone was occupied.
˿˿ Speed – Average lane speed during the interval. (Note that if Direc-

tion Protection is on, the speeds of any wrong-way detections aren’t 
factored into this average speed. If Direction Protection is off, 
wrong-way detections are factored into the average speed. See chap-
ter 7 for more details.)

˿˿ 85% – 85th percentile speed, meaning that 85% of the vehicles in the 
interval were going this speed or slower.

˿˿ Headway – Average time separation between vehicles in the interval, 
measured from front bumper to front bumper.

˿˿ Gap – Average time separation between vehicles in the interval, mea-
sured from back bumper of the front car and front bumper of the 
back car.

˿˿ Classes – How many vehicles fell into each of the length-, speed- 
and direction-based bins set on the Definitions screen.

Storage

Figure 86. Storage screen

Access the Storage screen by clicking the Storage button on the Data 
screen.

For more information. 
See support document 
299, How Does the 
SmartSensor HD 
Measure Occupancy? 
for more on how 
occupancy is 
calculated. 
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Understanding data storage tools
Setting Description Details
On/off switch Turns interval data storage 

on or off.
Turn this on for normal 
data collection.

Stop when 
FULL

Sets the sensor to stop 
storing data once the 
storage capacity is reached, 
meaning all new data after 
that point won’t be saved to 
memory.

Use this if you don’t want 
old data to be overwritten 
by new data, should the 
sensor’s memory fill up.

Oldest Shows the timestamp of 
when the earliest interval 
data packet currently saved 
to the sensor was stored.

Use this to see what 
timeframe your data storage 
covers.

Newest Shows the timestamp of 
when the most recent 
interval data packet was 
stored.

Use this to see what 
timeframe your data storage 
covers.

Total Shows the amount of time 
that data can be stored, 
based on the current lane 
and interval configuration.

Use this to know how much 
storage space is used on the 
sensor.

Remaining Shows how long until the 
sensor’s storage reaches 
capacity.

Use this to know how much 
storage space remains on 
the sensor.

Status bar and 
percentage

Shows how full the sensor’s 
storage is and how much 
storage capacity remains.

Use this to know how much 
storage space remains on 
the sensor.

Eraser Erases all the interval data 
currently saved to the 
sensor. 

This data can’t be recovered, 
so don’t click this until 
you’ve downloaded the data 
to your computer, if needed.

About storage capacity
The storage capacity shown on this screen is measured in time—how 
much time until the storage is full. This is affected by the size and fre-
quency of the interval packets that are saved.

˿˿ Larger packets—ones with more approaches, more bins, more lanes, 
etc.—will fill up the sensor’s storage faster.
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˿˿ Having a short interval means that there will be more frequent 
interval data packets, so the storage will fill up faster. A long interval 
means fewer packets and therefore you can leave the sensor alone for 
longer periods between your data downloads.

Always check back to this screen after you have changed all other set-
tings to get the most accurate information on how often your sensor will 
need to have information downloaded from it.

A few things can cause this screen to be incorrect: if you’re using a vir-
tual connection, or if the sensor setup is different now from what it was 
when the sensor started storing its current batch of data. In the latter 
case, the green status bar will be a better indicator of storage capacity.

Download
Access the Download screen by clicking the Download button on the 
Data screen.

Figure 87. Download screen

Downloading stored detection data
1	 Type a name for your download in the Name text field.
2	 If you want all the data currently on the sensor, keep the Download 

all of the data checkbox checked. If you want only part of the data, 
uncheck that checkbox, which will make the Begin: and End: fields 
editable. Set those to the desired begin and end date/times for your 
download.

Note. You can view a 
list of previous data 
downloads by clicking 
the green Downloads 
arrow in the lower 
right corner. A similar 
button can be found 
in the corner of the 
Data button on the 
main SSMHD screen.
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3	 Click Start Download.

Figure 88. Download Progress

4	 The Download Progress window will appear to show the status of 
the download. If you need to, use the buttons at the bottom of the 
window to start, pause or stop the download.

Figure 89. Export window

5	 When the download is complete, the Export window will appear, 
showing the following information about the downloaded file: its 
name, the date it was downloaded, information about the sensor, 
the number of intervals downloaded and the time frame that the 
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downloaded data covers.
6	 There are three formats you can view or export the downloads 

in: a comma delimited (.csv) file, a Microsoft Excel file, or a 
Wavetronix-specific text format that opens in a text editor like Note-
pad. To view the downloaded data, click the desired format’s icon on 
the View: (choose format) line.

7	 To export the downloaded data, click the checkbox next to your 
desired format on the Export: (choose format & location) line. 
Click the magnifying glass icon to change where to save the file, if 
desired, and then click Export.

Push

Figure 90. Push screen

Access the Push screen by clicking the Push button on the Data screen.

This function lets you push data from the sensor without waiting for a 
request from SSMHD. You can push event, interval or presence data.

Enabling data push
1	 Choose which kind of data you want to push, then click on the cor-

responding tab: Event, Interval or Presence.
2	 Click the Enabled checkbox.
3	 Choose which port you want to push the data on, RS-485 or RS-232. 

Be aware that both of these are half-duplex, meaning that they can’t 
send and receive data at the same time. If you use one of these ports 

Note. You can set 
the sensor to push 
multiple kinds of 
data at the same 
time, but if you do, 
set them to push 
on different ports.
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for pushing data, you might want to use a different port when con-
necting to the sensor.

4	 Choose which format you want the pushed data in.

Setting Description Details
All three pushed data types

HD Native SmartSensor HD 
(SS125) format.

Use this for a standard 
SmartSensor HD system.

SS105 Simple Emulates the original 
SmartSensor (SS105) 
format, without a multi-
drop header.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for a SmartSensor 105.

SS105 
Multidrop

Emulates the original 
SmartSensor (SS105) 
format, with a multi-drop 
header.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for a SmartSensor 105.

Event data only

Z4 2-Loop Emulates a dual-loop 
system. Speed and duration 
are measured using the loop 
size and spacing set in the 
Loop Emulation settings.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for dual inductive loops.

Z4 1-Loop Emulates a single-loop 
system. Duration is 
measured using the 
loop size set in the Loop 
Emulation settings.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for single inductive loops.

Z4 2-Loop 
Pulsed

Emulates a dual loop 
system; outputs will be held 
active for 125 ms for each 
vehicle detected, so only 
speed will be measured.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for dual inductive loops 
and all you need is vehicle 
presence and speed.

Z4 1-Loop 
Pulsed

Emulates a single-loop 
system; only indicates 
vehicle presence—no speed 
or duration information.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for single inductive loops 
and all you need is vehicle 
presence; this may be useful 
for doing counts.

Note. The Loop 
Emulation settings 

are found on the 
Settings screen and 

covered in chapter 6.

Definition. Z4 is a 
Wavetronix-specific 

protocol that lets 
sensors talk to other 
Wavetronix devices, 

mostly contact 
closure devices.
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Setting Description Details
Z4 1-Loop 
Speed

Emulates a single-loop 
system; has a set vehicle 
length of 15 feet, so the 
emphasis is on speed.

Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for single inductive loops 
and you are focused on 
speeds.

Interval data only

HD (legacy) Emulates the interval data 
from older versions of this 
sensor; it’s similar to the 
HD format but lacks speed 
bins and direction bins, and 
has fewer length bins.

Use this when you’re using a 
newer SmartSensor HD in a 
system that was designed for 
an older SmartSensor HD.

RTMS Emulates RTMS format. Use this when you’re using 
the SmartSensor HD in a 
system that was designed 
for an RTMS X3.

Presence data only

Z4 Presence Outputs presence data in 
the Z4 format.

Use this if your application 
needs the immediacy of 
presence data, and you need 
it to communicate with 
other Wavetronix devices 
such as contact closure 
cards.

5	 Set the destination, which is the address the sensor will push data to 
(only valid for HD and Z4 formats). For the HD format, it’s the 8-bit 
subnet/16-bit ID, and for the Z4 format it’s a 24-bit address. Make 
sure this destination address is unique for the communications bus 
in use.

6	 If you’d rather just broadcast the pushed data, click the Broadcast 
checkbox to push the data to the broadcast address (000/65535 for 
SS125 and 16777215 for Z4).

7	 Click OK to finish.

Note. Presence data 
has lower latency 
than event data, so 
it may be useful for 
applications that 
need the quickest 
possible data 
reporting. However, 
the trade-off is lower 
accuracy. For most 
applications, event 
data is the best choice.

Note. If the HD is 
pushing data to a 
custom software 
application, set 
the destination 
to 000/00000.
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 10
 Using  Tools

Figure 91. Tools button, main screen

Click the Tools button on the main screen to open the Tools screen.
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Figure 92. Tools screen

Backing up and restoring sensor setup files

Figure 93. Backup-Restore screen
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Setting Description Details
Backup File Allows you to create 

a backup file (.ssc) of 
the sensor settings you 
currently have configured.

Click the magnifying glass 
to navigate to where you 
want to create the backup 
file; type a name and hit 
OK. Click the Back-up 
Sensor Setup button to 
save the backup file to your 
computer.

This may be useful if you 
are making changes to the 
sensor and want to back 
up your configuration 
before you do so, so that 
you have a known good 
configuration to fall back 
on if necessary.

Alternatively, it may be 
useful if you are replacing a 
sensor in the field, and you 
want to quickly apply the 
settings from the old sensor 
to the new one. 

Restore File Loads a backup file (.ssc) 
to the sensor, replacing 
the current sensor 
configuration with the 
configuration saved to the 
.ssc file.

Click the magnifying glass 
to navigate to where the 
desired backup file is saved; 
select it and hit OK. Click 
the Restore Sensor Setup 
button to apply the saved 
configuration from the 
backup file to the sensor.

This may be useful if you 
have made changes to the 
sensor and need to restore 
a backed-up configuration 
from a saved file (see 
above). 

Restore 
Factory Setup

Sets all sensor settings back 
to the factory defaults.

N/A
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Viewing licensing information

Figure 94. Licensed Features screen

Setting Description Details
Serial Number Shows the serial number of 

the sensor.
N/A

License Date Shows the date the sensor 
was licensed.

N/A

Feature Shows a list of all possible 
sensor features, along with 
its status: whether or not it 
is enabled under the current 
license, or, for variable 
features such as number of 
lanes, the number that is 
currently allowed under the 
current license.

Explanations of what each 
of these features are can be 
found throughout the rest 
of this guide.

License File Currently not in use. N/A
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Accessing power options

Figure 95. Power screen

Setting Description Details
Power Up / 
Power Down

Shows the timestamp of 
the last time the sensor 
powered up or down.

May be useful for 
diagnostic purposes, to see 
if the sensor has lost power 
at some point.

Reboot Shows the timestamp of 
the last time the sensor was 
rebooted. Click the Reboot 
button to reboot the sensor.

May be useful for when you 
have a remote connection 
to the sensor and need to 
reboot.
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SYMBOLS
8-conductor cable  18. See also cable
9-conductor cable  18. See also cable
85th percentile  80, 83
.NET Framework  31

A
accuracy  12, 59, 70, 75, 89
Add Lane button  53, 66
address book  38
alignment  16–17, 49–51, 60, 62, 70

troubleshooting  50
approach  80–81, 82
automatic configuration  51–67, 55
Automatic Lane window  57, 62–63

B
backplate  27–29
backup-restore  91–92
baud rate  34, 37, 45
bi-directional lanes  64, 76, 81
bin definitions  78–81

C
cabinet. See traffic cabinet
cable  10, 18, 22, 24, 29

grip  21, 22, 25, 26
lengths  10

Capture button  63
Centers sidebar  56
circuit breaker  23, 29
class  59, 70, 71, 80, 83
Clear Edit Area  52
Click 200  23, 29
Click 301  35
COM port. See port
Configuration screen  48–67
Connect screen  33–41

troubleshooting  37, 38
contact closure  88, 89
Copy Lane  52, 57
Copy Sidebar  52, 57
counts  71, 88

D
data download  85–87
data push  87–89
Data screen  77–89
data settings  47
data storage  83–85
Date & Time setting  44
default settings  76, 92
Definitions screen  78–81
detection  9, 10, 14, 75

thresholds  75
direction  58, 81, 89
Direction Protection  64, 76, 83
Download screen  85

E
earth ground  23, 26, 29
error log  38
event data  87–89
Exclude button  52, 63, 65
exporting data  86–87
extension time  76

F
firmware

downgrade  41
upgrade  40

flow control  34

G
gap/headway  83
general settings  43–44
guard rails  14

H
hardware handshaking  34, 45
Hide Auto Lanes  52, 61, 63
hills, mounting on  17
homerun cable  24, 26, 27, 29. See also cable

I
Include button  52
installation

cable  17–18
pole-mount box  19–23

INDEX
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sensor  15
SmartSensor Manager HD  30–31
traffic cabinet  27–29

Internet connection  35, 38
interval data  46, 75, 79, 80, 84, 85, 87, 89

Interval Data screen  81–83
isolated sensor (Connect screen)  34, 35

J
jersey barriers  13, 14

L
lane adjustments  74–76
lane configuration  51–67

adding a lane  53, 66
capturing lanes  51–52, 58
deleting a lane  54, 65
editing a lane  53, 64
excluding/including a lane  52, 63, 65, 67
saving configuration  54

lane name  53–54, 61, 64
lane verification  68–76

using logging  73–74
using per vehicle data  72–73
using sidebars  70–71
using vehicle display options  69–70

language  32
legacy protocol  47, 89
length. See also class

thresholds  75
licensed features  93
logging (Verification screen)  73–74
loop emulation  46, 88

M
Max Vehicle Length  47
midblock detection  10
mount  15, 16, 18
mounting guidelines table

in feet  11
in meters  12

mounting height  11, 12, 14
mounting location  9, 10, 14, 70, 71, 72, 74
mounting straps  15
multi-drop network (Connect screen)  34, 35
multipath  13–14, 59, 75

N
Network Address  35
non-parallel lanes  51, 52

O
occlusion  12–14
occupancy  46, 75, 83
offset  11, 12
onboard storage  78, 79, 80
on/off-ramps  9, 51
outputs settings  46–47

P
password protection  39
per vehicle data  69, 72–73
pole  15, 18, 19–20, 24–25

installation of  11
pole-mount box  19–23
port  34, 35, 37, 87–88
ports settings  44–45
power  21, 24

solar, battery  19
power plant  20, 23, 27, 29
power up/power down the sensor  94
presence data  70, 87, 89
Push screen  87–89

R
range  10, 57, 59
reboot the sensor  94
response delay  45
Restart Auto Cfg  52, 60
RF channel  14, 46
RS-232  23, 29, 34, 45, 87
RS-485  10, 23, 29, 45, 87

termination  45
RTMS (X3) protocol  47, 89

S
semi trucks  13, 76
serial connection  34, 38
serial number  43, 93
Settings screen  42–47
Show Auto Lanes  52, 54, 61
sidebars, configuration  51, 55–56
sidebars, verification  69, 70, 71
silicon dielectric compound  17–18
SmartSensor Manager HD. See names of individual 

screens, features or settings .
sounding walls  13, 14
Source, antenna or diagnostic  46
speed  59, 70, 71, 79, 83, 89

thresholds  75
SS105 protocol  47, 88
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Standard Preassembled Backplate  27
Standard Preassembled Cabinet  20, 23
storage capacity  84
Storage screen  83–85
subnet/ID  43
Surge Preassembled Cabinet  24, 25
surge protection  23, 29

T
terminal blocks  21–23, 25–29
terminal server  35, 37
thresholds  74–76
timeout  34, 35
Tools menu (Configuration screen)  51, 54, 60
Tools screen  90–94
Tracks sidebar  56
traffic cabinet  24–29
tunnels  14

V
Vehicle Display menu  54, 59
vehicle length  46, 47, 59, 70, 75, 80
Verification screen  68–76
version control  40–41
View menu (Configuration screen)  51, 52, 54, 61–62
virtual connection  36, 38, 85
virtual sensor file  36
volume  70, 71, 75, 83

thresholds  75

W
warranty  8, 19, 23, 29
wireless  10, 19
wrong-way detections. See Direction Protection

Z
Z4 protocol  88–89
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The SmartSensor Mount Datasheet is inserted on the following page. 



SmartSensor Mount

Pole mount for SmartSensors
The SmartSensor™ mount makes installation quick and easy by helping you securely mount any of 
the Wavetronix SmartSensors. Sturdily built of powder-coated aluminum for durability and weather-
resistance, this mount can withstand whatever the elements throw at it.

˿˿ Two axes of rotation for horizontal 
and vertical positioning

˿˿ Mates with fixed and rotational 
backplates on the SmartSensor V, 
HD, Advance, and Matrix

˿˿ Symmetric hole pattern for flex-
ibility in sensor attachment

˿˿ Two contact points for attachment 
to circular or non-circular poles

˿˿ On circular wpoles, another axis 
of rotation around the pole is 
available

˿˿ Accepts ¾” banding
˿˿ Heavy duty aluminum construction 

makes mount sturdy and long-
lasting

˿˿ Powder coated for oxidization 
resistance, allowing mount to 
withstand the harshest weather 
conditions of features

˿˿ Supports a 20-lb. (9.1-kg) load

8 in.6 in.

13.61 in.

3.79 in.
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SmartSensor Mount

Technical specifications
Mounting

˿˿ Rotational axes: 2
̀̀ NOTE: SmartSensor Advance and SmartSensor Matrix are 

shipped with rotational backplate for third axis of rotation. 
SmartSensor V and SmartSensor HD can be ordered with 
rotational backplate if third axis is required.

˿˿ Maximum load: 20 lbs. (9.1 kg)
˿˿ Symmetric hole pattern that mates with fixed and rotational 

SmartSensor backplates
˿˿ Contact points with pole: 2
˿˿ Slotted for ¾-in. (1.9-cm) banding
˿˿ Additional degree of movement achieved by using the 

     360-0129

Construction
˿˿ Constructed of aluminum 0.1875 in. (0.48 cm) thick
˿˿ 316 stainless steel hardware
˿˿ Powder coated
˿˿ Weight: 3 lbs. (1.36 kg)

Ordering information
SmartSensor Mount
SS-611

Accessories
360-0129 – Add-on Knuckle

Contact us
801.734.7200
sales@wavetronix.com
www.wavetronix.com
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SmartSensor Mount

Bid specifications
1.0 General. This item shall govern the purchase of a traffic sensor mounting assembly equivalent to the Wavetronix SmartSensor™ mount.

2.0 �Mounting. The mounting assembly shall provide at least two axes of rotation to ensure proper installation.

The mounting assembly shall be able to support at least a 20-lb. (9.1-kg) load.

The mounting assembly shall feature a symmetric hole pattern that mates with fixed and rotational SmartSensor backplates.

The mounting assembly shall have two contact points with the pole.

The mounting assembly shall be slotted for 3/4-in. (1.9-cm) banding.

3.0 Construction. The mounting assembly be constructed of 0.1875 in. (0.48 cm) thick or thicker aluminum with 316 stainless steel hard-
ware.

The mounting assembly shall be powder coated for oxidation resistance.

The mounting assembly shall weigh 3 lbs. (1.36 kg).
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The MVD Guide is inserted on the following page. 




